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The information in this document is current as of November 2005. The information is subject to change without notice. 
For actual design-in, refer to the latest publications of NEC Electronics data sheets or data books, etc., for the most up-
to-date specifications of NEC Electronics products. Not all products and/or types are available in every country. Please 
check with an NEC sales representative for availability and additional information. 
 
No part of this document may be copied or reproduced in any form or by any means without prior written consent of 
NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may appear in this document. 
 
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual property 
rights of third parties by or arising from the use of NEC Electronics products listed in this document or any other 
liability arising from the use of such NEC Electronics products.  No license, express, implied or otherwise, is granted 
under any patents, copyrights or other intellectual property rights of NEC Electronics or others. 
 
Descriptions of circuits, software and other related information in this document are provided for illustrative purposes 
in semiconductor product operation and application examples.  The incorporation of these circuits, software and 
information in the design of customer's equipment shall be done under the full responsibility of customer.  NEC 
Electronics no responsibility for any losses incurred by customers or third parties arising from the use of these circuits, 
software and information.  
 
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, customers 
agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To minimize risks of 
damage to property or injury (including death) to persons arising from defects in NEC Electronics products, customers 
must incorporate sufficient safety measures in their design, such as redundancy, fire-containment and anti-failure 
features. 
 
NEC Electronics products are classified into the following three quality grades: “Standard”, “Special” and “Specific”. 
 
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-designated 
“quality assurance program” for a specific application.  The recommended applications of NEC Electronics product 
depend on its quality grade, as indicated below.  Customers must check the quality grade of each NEC Electronics 
product before using it in a particular application. 
 
"Standard": Computers, office equipment, communications equipment, test and measurement equipment, audio and 
visual equipment, home electronic appliances, machine tools, personal electronic equipment and industrial robots. 
 
"Special":  Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster systems, 
anti-crime systems, safety equipment and medical equipment (not specifically designed for life support). 
 
"Specific":  Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life support 
systems and medical equipment for life support, etc. 
 
The quality grade of NEC Electronics products is “Standard” unless otherwise expressly specified in NEC Electronics 
data sheets or data books, etc. If customers wish to use NEC Electronics products in applications not intended by NEC 
Electronics, they must contact NEC Electronics sales representative in advance to determine NEC Electronics 's 
willingness to support a given application. 
 
Notes: 

1. "NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 
 majority-owned subsidiaries. 

2.  "NEC Electronics products" means any product developed or manufactured by or for NEC Electronics 
 (as defined above). 
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CAUTION 
 

This test and measurement equipment has the potential to be significantly altered by its 
user through hardware enhancements/modifications and/or test or application software. 
Thus, with respect to Council Directive 89/336/EEC (Directive on Compliance with the 
EMC Protection Requirements), this equipment has no autonomous function. 
Consequently this equipment is not marked by the CE symbol. 

EEDT-ST-0005-10 
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1. Introduction 

DemoKit-LG2 is a demonstration kit for the NEC Electronics 8-bit 78K0S/LG2 microcontrollers 
(MCUs) with integrated liquid crystal display (LCD) controllers. The kit supports on-board flash 
programming and real-time execution of application programs up to 32 KB using NEC Electronics’ free 
C compiler and assembler. The board contains user hardware such as digital input/output (I/O) and 
analog signals. 

1.1 Features 

� Easy-to-use device demonstration capabilities, including elements to easily demonstrate simple I/O 
functions such as the navigator switch, 112-segment LCD panel, phototransistor, temperature 
sensor, I/O lines, UART serial interface, and others. 

� On-board debugging function using the ID78K0-TK debugger that allows flash downloading and 
standard debugging functions such as code execution and single-step command execution, 
breakpoints, memory manipulation, and so forth. 

� Power supplied through the Universal Serial Bus (USB) interface, the QB-78K0MINI on-chip 
debugging emulator, or an external CR2032 3-volt lithium coin battery 

� Standard 112-segment LCD panel that allows the implementation of human / machine interface, 
comfortable I/O functions, output of measurement values, output of status information, etc.  

� Windows®-based FPL3 flash programming software that enables you to select and download 
application programs for evaluation purposes. 

� Analog-to-digital (A/D) signal conversion 

� Various I/O signals designed to be connected to user hardware 

− Standard 112-segment LCD panel (8 digits × 14 segments each) 

− Timer I/O signals 

− Two- or three-wire serial I/O 

− UART interface via FT232 USB UART chip  

− Eight analog input lines 

− KTY13-5 temperature sensor  

− PT15-21C phototransistor  

− Navigation switch for key interrupt generation 

� NEC Electronics C compiler and assembler (maximum 32 KB program code size) 

� Full documentation for the NEC Electronics 78K0/LG2 MCU, software tools and FPL3 flash 
programming software 

Note: DemoKit-LG2 is not intended for code development. NEC Electronics does not support any 
application of the DemoKit-LG2 in a commercial or technical product. 

 1
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1.2 System Requirements 

Table 1. System Requirements 

Windows® 98SE, Windows ME, Windows 2000 or Windows XP for the NEC Electronics 
software tools and FPL3 flash programming software 

Host 
computer 

Intel® Pentium® 166 MHz (at least), 128 MB of RAM, 256-color display (1024 × 768), 
mouse, CD-ROM drive and 200 MB of free hard disk space for installation of tool packages 

Host interface USB interface to enable communication based on USB 1.1 or later 

1.3 Kit Contents 

Please verify that you have received all parts listed on the contents list attached to the kit package. If 
any part is missing or appears damaged, please contact your local sales representative for instructions 
about how to return the kit for replacement or repair. 

Note: Updates for the NEC Electronics software tools, FP3 flash programming software, documentation 
and/or utilities for DemoKit-LG2, if available, may be downloaded from the NEC Electronics America 
web site at http://www.am.necel.com/microcontrollers/devtools.php. 

http://www.am.necel.com/microcontrollers/devtools.php
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2. System Configuration 
 

Configuration of the DemoKit-LG2 system is shown in Figure 1. 

Figure 1. System Configuration 
 

 

2.1 DemoKit-LG2 

DemoKit-LG2 is a demonstration kit for the NEC Electronics 8-bit 78K0/LG2 MCUs with integrated 
LCD controllers. The board connects to a host computer by means of a USB interface cable. The system 
may be used for on-board flash programming of the MCU’s internal flash memory and for execution of 
application programs. The board also supports on-chip debugging using the ID78K0-TK debugger. 

DemoKit-LG2 runs the MCU at 6.0000 MHz and provides a 32.768 kHz subclock. 

2.2 Host Computer 

The USB host interface enables communication to the DemoKit-LG2 board. The FT-232 USB UART 
chip allows application software to access the USB device in the same way it would access a standard 
RS-232 interface. The FTDI's virtual COM port (VCP) driver appears to the Windows-based system as 
an extra communication port, in addition to any existing hardware communication ports.  

2.3 Power Supply via USB Interface 

The DemoKit-LG2 supports a flexible configuration of its power supply. The board can be powered by 
the USB interface, the QB-78K0MINI on-chip debugging emulator, or by an external CR2032 3-volt 
lithium coin battery. 

3. Components 

The DemoKit-LG2 board is equipped with a navigation switch, 112-segment LCD panel, temperature/ 
light sensor, and several connectors for connection to the host computer, flash programmer, and external 
target hardware. 

 3
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Figure 2. Top View of Board Connectors and Switches 
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Figure 3. Bottom View of Board Connectors and Switches 

 

CN2 

BAT1 

Some of the DemoKit-LG2 components are available for user application hardware and software. Please 
read the MCU user’s manual carefully to get information about the electrical specification of the 
available I/O ports before connecting any external signals to the DemoKit-LG2 board. 

3.1 Jumper JP1: Power Supply Selection 

The different power supply modes can be set using jumper JP1. The JP1 jumper controls the power 
supply during standalone mode, flash programming and on-board debugging. Additionally, power can 
be applied using the QB-78K0MINI on-chip debugging emulator or JP2 jumper. 

 5
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JP1 Setting Mode 

1–2 Closed (default)  USB interface-supplied power (CN7) 

2–3 Closed Battery-supplied power (BAT1) 

3.2 Jumper JP2: Power Selection for On-Chip Debugging 

The power supply can also be applied using the QB-78K0MINI on-chip debugging (OCD) emulator. 
Close jumper JP2 to apply power from the QB-78K0MINI. 

JP2 Setting Mode 

Open (default) Power supply via USB or battery1-2 

Closed Power supply via QB-78K0MINI emulator

3.3 Jumper JP3: Clock Supply Selection 

Jumper JP3 controls the MCU’s clock supply. Closing JP3 applies an external frequency of 6 MHz to 
the MCU’s P122/X2 clock input pin. Opening JP3 allows an external oscillator to be used when pad X1 
(not assembled) of the kit is equipped with a corresponding oscillator. 

JP3 Jumper Setting Mode 

1-2 Closed (default)  Clock frequency = 6 MHz, supplied by CPLD 

 Open 
Clock supply by external oscillator. By using this mode be 
sure to equip a crystal oscillator to the X1 pad. For using the 
QB-78K0MINI on-chip debugging emulator 

3.4 SW1 Configuration Switches 

The board’s different operating modes can be set using SW1 switches S1–S4.  

SW1 Factory Setting Mode 

S1 OFF Normal operation 

S2 OFF UART6 selected 

S3 OFF On-chip debugging disabled 

S4 OFF On-board debugging enabled 

3.4.1 SW1/S1: Operating Mode Selection 

SW1 switch S1 controls the DemoKit-LG2 board’s operating mode. Setting SW1/S1 to ON allows you 
to reprogram the MCU’s internal flash memory using the FPL3 flash programming software. 
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SW1/S1 Mode 

OFF (default) Normal operation 

ON Flash memory programming 

During normal operation, the user program stored in the MCU’s flash memory is executed. 

3.4.2 SW1/S2: UART Selection 

SW1/S2 specifies the MCU’s UART signals that correspond to the FT232 interface lines. 

SW1, S2 Selection 

OFF (default) UART6 

ON UART0 

3.4.3 SW1/S3: On-Chip Debugging Selection 

SW1/S3 controls the MCU’s on-chip debugging function. Setting switch S3 to ON allows you to use 
the on-board debugging function or connect to the QB-78K0MINI on-chip debugging emulator. 

SW1, S3 Setting 

OFF (default) Disabled 

ON Enabled 

3.4.4 SW1/S4: On-Chip Debugging Mode Selection 

SW1/S4 controls the debugging mode. Switching SW1/S4 to OFF allows you to use the board’s on-
board debugging function via the default USB/UART connection to the host computer. All standard 
debugging functions such as flash programming and downloading, code execution, single-step 
command execution, setting breakpoints, memory manipulation, and so forth are available. 

Setting switch SW1/S4 to ON allows you to connect the QB-78K0MINI on-chip debugging emulator 
(available separately) to the board to use the MCU’s on-chip debugging functions. 

SW1, S4 Mode 

OFF (default) On-board debugging function enabled 

ON QB-78K0MINI connection enabled 

3.5 SW2 Reset Switch 

The SW2 reset switch activates the power-on reset function and is connected to the MCU’s reset input. 

Note: Supplying power to the board via the battery inactivates the reset switch. Please use jumper JP1 
to turn power OFF/ON to the microcontroller. 

 7
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3.6 SW3 Navigation Switch 

The SW3 navigation switch connects to the MCU’s key interrupt port and operates in five directions, 
including from the center pushbutton (Figure 4). 

SW3 Connection to Microcontroller 

Left P73/KR3 

Down P71/KR1 

Select P74/KR4 

Right P72/KR2 

Up P70/KR0 

Figure 4. SW3 Navigation Switch 
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3.7 SB1, SB3, SB4, SB5 and SB6 Soldering Bridges 

The SB1, SB3, SB4, SB5 and SB6 soldering bridges allow the board to be configured in a variety of 
ways, as described in Table 2. 

Figure 5. Soldering Bridges  

1  2  3 

1  2  3 

SB1 

SB5 
SB6 

3  2  1 

3  2  1 SB3 
SB4 

 

Table 2. Soldering Bridge Settings 

Soldering Bridge Pad Setting Configuration 
Closed (default) VCC connected to AVREF pin 

SB1 1–2 
Open VCC disconnected from AVREF pin 

1–2 
2–3 

Closed (default) 
Open   (default) 

Subclock oscillator connected to P123/XT1 pin 
SB3 

1–2 
2–3 

Open 
Closed 

P123/XT1 pin connected to CN5–2 

1–2 
2–3 

Closed (default) 
Open   (default) 

Subclock oscillator connected to P124/XT2 pin 
SB4 

1–2 
2–3 

Open 
Closed 

P124/XT2 pin connected to CN5–4 

1–2 
2–3 

Closed (default) 
Open   (default) 

Main clock oscillator connected to P121/X1 pin 
SB5 

1–2 
2–3 

Open 
Closed 

P121/X1 pin connected to CN3–38 

1–2 
2–3 

Closed (default) 
Open   (default) 

Main clock oscillator connected to P121/X2 pin 
SB6 

1–2 
2–3 

Open 
Closed 

P121/X2 pin connected to CN3–40 

Cutting the default connections (pad 1–2) of soldering bridges SB3/SB4 and SB5/SB6, respectively, 
and closing pads 2–3 connects the corresponding MCU signals to the CN3 and CN5 external 
connectors, respectively. In this mode, the MCU pins can be used as standard I/O ports, but you must 
configure the MCU’s clock generator accordingly. 

Note: Do not close the connection for the clock oscillator and external connectors at the same time. This 
can have a negative effect on the operation of the subclock and main clock oscillators. 

 9
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3.8 CN7 USB Interface Connector 

The CN7 connector provides a means to connect the board to FPL3 flash programming software to 
program application software into the MCU’s internal flash memory. Additionally, the on-board 
debugging function uses connector CN7 for communication with the host computer. CN7 also provides 
the board’s 5-volt power supply. 

For standard communication to a host computer, for example, using a terminal program, the MCU’s 
UART6 and UART0 I/O signals are connected to CN7. 

CN7 USB Connector Signal Name 

1 VBUS 

2 DM 

3 DP 

4 No connection 

5 GNDBUS 

Figure 6. Pin Configuration of CN7 USB Mini B-Type Host Connector 

1 5

 
For connection to the host computer, use a mini-B-type USB cable. For confirmation, NEC Electronics 
used only the USB cable delivered with the DemoKit-LG2 board. 
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3.9 CN2 Flash Programmer Connector 

The CN2 connector (not assembled) allows connection of the PG-FP4 flash programmer (available 
separately) to DemoKit-LG2 to program application software into the MCU’s internal flash memory. 

CN2 Signal 

1 GND 

2 RESET 

3 SI 

4 VCC 

5 SO 

6 No connection 

7 SCK 

8 No connection 

9 No connection 

10 No connection 

11 No connection 

12 FLMD1 

13 No connection 

14 FLMD0 

15 No connection 

16 No connection 

When using the PG-FP4, you must set the programming interface to the MCU in accordance with the 
clock serial interface (CSI ring oscillator), please configure the DemoKit-LG2 as following: 

Table 3. Hardware Configuration When Using the PF-FP4 Flash Programmer 

Switch/Jumper Setting Mode 

S1 OFF Normal operation

S2 OFF UART6 select

S3 OFF OCD disabled

S4 OFF On-board debugging

JP1 1–2 closed Power supply via USB

JP2 Open Power supply via USB

JP3 Closed Clock supplied via CPLD

 11
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3.10 OCD connector CN8 

Connector CN8 (not assembled) allows connection of the QB-78K0MINI on-chip debugging 
emulator (available separately) to the DemoKit-LG2 to use the MCU’s on-chip debugging 
function. 

Table 4. CN8 On-Chip Debugging Connector 

CN8 Signal 

1 RESET_IN 

2 RESET_OUT 

3 FLMD0 

4 VDD_IN 

5 X2 

6 GND 

7 X1 

8 GND 

9 No connection 

10 No connection 

To enable on-chip debugging using the QB-78K0MINI emulator, you must configure the DemoKit-LG2 
as described in Section 4.2. 

Table 5. SW1 Configuration for On-Chip Debugging 

Switch/Jumper Setting Mode 

S1 OFF Normal operation

S2 OFF UART6 select

S3 ON On-chip debugging enabled

S4 ON QB-78K0MINI enabled

JP1 1–2 closed Power supply via USB

Open Power supply via USB
JP2 

Closed Power supply via QB-78K0MINI (*Note)

JP3 Open Clock supplied via QB-78K0MINI

For information about how to configure DemoKit-LG2 for on-chip debugging, refer to 4.1. 

3.11 LCD1 Standard 112-Segment LCD 

The DemoKit-LG2 board is equipped with a standard 112-segment LCD, in this case a transflective 
model operating at a 5-volt supply voltage. The LCD can operate at a four times multiplex rate. The 
display can be used within a temperature range from –20 to +70° Celsius. The typical driving frequency 
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is equal to 32 Hz (maximum 100 Hz) within the complete temperature range. The LCD pin assignments, 
connections and segment definition is shown in Table 6: 

Table 6. LCD Pin Assignments and Connections 
LCD 
 

LCD  
 

Pin COM1 COM2 COM3 COM4 

78K0/LG2 
MCU 

Pin COM1 COM2 COM3 COM4 

78K0/LG2 
MCU 

1 S1 1F 1E 1D S0 36 1H 1G 1L 1M S2 

2 1I 1J 1K 1N S1 35 1A 1B 1C P1 S3 

3 S2 2F 2E 2D S4 34 2H 2G 2L 2M S6 

4 2I 2J 2K 2N S5 33 2A 2B 2C P2 S7 

5 S3 3F 3E 3D S8 32 3H 3G 3L 3M S10 

6 3I 3J 3K 3N S9 31 3A 3B 3C P3 S11 

7 S4 4F 4E 4D S12 30 4H 4G 4L 4M S14 

8 4I 4J 4K 4N S13 29 4A 4B 4C P4 S15 

9 S5 5F 5E 5D S16 28 5H 5G 5L 5M S18 

10 5I 5J 5K 5N S17 27 5A 5B 5C P5 S19 

11 S6 6F 6E 6D S20 26 6H 6G 6L 6M S22 

12 6I 6J 6K 6N S21 25 6A 6B 6C P6 S23 

13 S7 7F 7E 7D S24 24 7H 7G 7L 7M S26 

14 7I 7J 7K 7N S25 23 7A 7B 7C P7 S27 

15 S8 8F 8E 8D S28 22 8H 8G 8L 8M S30 

16 8I 8J 8K 8N S29 21 8A 8B 8C P8 S31 

17 NC NC NC COM4 COM4 20 COM0 NC NC NC COM0 

18 NC NC COM3 NC COM3 19 NC COM1 NC NC COM1 

Figure 7. LCD / Segment Definition 

 

   

 
 

 13
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3.12 Temperature Sensor 

For temperature measurement and primarily as an application example, a silicon temperature sensor 
KTY13-5 is connected to the input port of the 16-bit timer/event counter 00, equal to port P00 of the 
MCU. The temperature sensor has a resistor range of R25 min = 1950 Ω and R25 max = 1990 Ω at 25° 
centigrade, with IOP = 1 mA. The distribution of the temperature factor kT is shown in Table 7: 

Table 7. Distribution of Temperature Factor kT 

 
1. Normalizing point 

 

The sensor resistance can be calculated as RT =  kT * R25 =  ∫(TA). 
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Figure 8. Typical Dependence of Sensor Resistance 

 
The following equation, which approximates the characteristic curve, calculates temperature at the 
sensor according to the change in the sensor’s resistance: 

α² - 4 x β + 4 x β x kT - α
T  = 25  + ° C

2 x β

-3α = 7,88 x 10  x K

β = 1,937 x 10  x K

kT = 

-1

-5 -2

RT

R25

with:

α² - 4 x β + 4 x β x kT - α
T  = 25  + ° C

2 x β

-3α = 7,88 x 10  x K

β = 1,937 x 10  x K

kT = 

-1

-5 -2

RT

R25

-3α = 7,88 x 10  x K

β = 1,937 x 10  x K

kT = 

-1

-5 -2

RT

R25

with:

  
The temperature is measured using the dual-slope method in which a resistor value can be converted 
into a digital countervalue. To do this, the charging time of capacitor C18 will be measured with the 16-
bit timer/event counter 00 of the MCU. The first charging slope will use a reference resistor (RREF = R6) 
and the second charging slope a variable resistor (RVAR = R5 + RT), which should be determined. By 
comparing the two measured times and the known reference resistor RREF, the variable resistor can be 
calculated. 

All of the 78K0/LX2 MCUs have bit-settable I/O ports and Schmitt-trigger inputs such as the TI000 
timer input port. The DemoKit-LG2 uses the P0 bit-settable port as a bidirectional port. 

At first, the complete port P0 is cleared and set to output mode. In this case, the C18 capacitor is 
discharged via P00/TI000 and prepared for the first measurement. The R7 resistor is only used to limit 
the current during the discharging of the capacitor. Then port P02 is set to 1 and output. At this point, 
the 16-bit timer/event counter 00 is started. The rest of the port P0 is set to input (high impedance). So 
the capacitor will be charged via the R6 reference resistor. When the capacitor has reached the threshold 
level of the Schmitt-trigger input P00/TI000, the actual timer value is automatically captured and an 
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internal interrupt is generated. The capture value is read using this interrupt. In the next step, the C18 

capacity will be discharged again. The same procedure starts once more with port P03. This time the 
capacitor is charged via the unknown resistor RVAR of the temperature sensor and after the threshold is 
reached again the second timer value is read out. 

The unknown RVAR, and consequently the resistor value of the temperature sensor, can be calculated 
from the two values obtained using the method described earlier. 

RREF:  R6 = VCREF = VDD 1 - e 

tREF

RREF x C
-

RVAR:  R5 + RT = VCREF = VDD 1 - e 

tVAR

RVAR x C
-

VC = VCVAR = VCREF = const 

 
The threshold level of the Schmitt-trigger input does not have any influence on the accuracy of the 
measurement, as this will be a constant for both measurements. 
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VDD 1 - e 

tREF

RREF x C
-

VDD 1 - e 

tVAR

RVAR x C
-

=

1 - e 

tREF

RREF x C
-

1 - e 

tVAR

RVAR x C
-

=

e 

tREF

RREF x C
-

e 

tVAR

RVAR x C
-

=

tREF

RREF x C
tVAR

RVAR x C=

tREF

RREF

tVAR

RVAR
=

tREF
RREF   x tVARRVAR =

VDD 1 - e 

tREF

RREF x C
-

VDD 1 - e 

tVAR

RVAR x C
-

=

1 - e 

tREF

RREF x C
-

1 - e 

tVAR

RVAR x C
-

=

e 

tREF

RREF x C
-

e 

tVAR

RVAR x C
-

=

tREF

RREF x C
tVAR

RVAR x C=

tREF

RREF

tVAR

RVAR
=

tREF
RREF   x tVARRVAR =

 
 

The C18 capacitor and VDD supply voltage do not influence the accuracy of the measurement. Only the 
absolute value of the RREF reference resistor has an influence, because these parameters will not change 
during one measurement. The RVAR resistor can be calculated using the RREF, tREF and tVAR values. 
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Figure 9 shows a diagram of the dual-slope circuit: 

Figure 9. Dual-Slope Circuit 

R6

R5

R7

C18

S1
(RT)

P02
P03

P00 / TI000

78K0/LG2

RREF = R6
RVAR   = R5 + RT

RT = temperature sensor resistance

R6

R5

R7

C18

S1
(RT)

P02
P03

P00 / TI000

78K0/LG2

RREF = R6
RVAR   = R5 + RT

RT = temperature sensor resistance

 

The charging time of the capacitor can be calculated as follows: 

VC = VDD 1 - e 

t
R x C

-

= 1 - e 

t
R x C

-

VDD

VC

=  e R x C
-

VDD

VC

t

1 -

R x C
t

VDD

VC1 -=  ln

VDD

VC1 -t  = - R x C x ln

-

VC = VDD 1 - e 

t
R x C

-

= 1 - e 

t
R x C

-

VDD

VC

=  e R x C
-

VDD

VC

t

1 -

R x C
t

VDD

VC1 -=  ln

VDD

VC1 -t  = - R x C x ln

-
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Example: 

VDD = 5 V; Vthreshold = VC = (0,4 … 0,7) VDD 
Typical: Vthreshold = 0,6 × VDD 
RREF = 10 kΩ; C = C18 = 220 nF 

VDD

VC1 -t  = - RREF x C x ln

1 - 0t  = - 10 kΩ x 220 nF x ln

t  =  2,0158 ms

VDD

VC1 -t  = - RREF x C x ln

1 - 0t  = - 10 kΩ x 220 nF x ln

t  =  2,0158 ms

 

3.13 Q1 Phototransistor 

For light incidence measurement and primarily as an application example, a PT15-21C phototransistor 
is connected to the ANI0 analog input, which is equal to port P20 of the MCU. 

3.14 BUZ1 Buzzer 

To generate acoustic signals and sound waves, a buzzer is connected to the timer output port of the 16-
bit timer/event counter 01, equal to port P06/TI011/TO01 of the MCU. The AC buzzer operates in a 
voltage range of 2–5 volts. 

3.15 BAT1 Battery Holder 

To power the board via battery, equip the BAT1 battery holder with a CR2032 3-volt lithium coin-type 
battery. 
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3.16 CN3, CN4 and CN5 External Connectors 

CN3, CN4 and CN5 are connectors for external user hardware. The MCU signals are connected to CN3, 
CN4 and CN5. The DemoKit-LG2 board also provides a wire-wrap field area—connector CN3—for the 
integration of additional application hardware. 

Figure 10. CN3, CN4, and CN5 Connections to MCU 

 
 

CN3 Signal CN3 Signal  CN
4 

Signal CN4 Signal  CN5 Signal CN5 Signal 

1 VCC 2 P25/ANI5  1 VSS 2 P00/TI000  1 N.C. 2 P123/XT1
3 VCC 4 P26/ANI6  3 VSS 4 P01/TI010/TO00  3 N.C. 4 P124/XT2
5 VCC 6 P27/ANI7  5 VSS 6 P02/SO11  5 N.C. 6 N.C. 
7 VCC 8 P30/INTP1  7 VSS 8 P03/SI11  7 N.C. 8 N.C. 
9 VCC 10 P31/INTP2  9 VSS 10 P04/SCK11  9 N.C. 10 N.C. 
11 VCC 12 P32/INTP3  11 VSS 12 P05/TI001/SSI11  11 N.C. 12 N.C. 
13 VCC 14 P33/INTP4/TI51/TO51  13 VSS 14 P06/TI011/TO01  13 N.C. 14 N.C. 
15 VCC 16 P60/SCL0  15 VSS 16 P10/SCK10/TXD0  15 N.C. 16 N.C. 
17 VCC 18 P61/SDA0  17 VSS 18 P11/SI10/RXD0  17 N.C. 18 N.C. 
19 VCC 20 P70/KR0  19 VSS 20 P12/SO10  19 N.C. 20 N.C. 
21 VCC 22 P71/KR1  21 VSS 22 P13/TXD6  21 N.C. 22 N.C. 
23 VCC 24 P72/KR2  23 VSS 24 P14/RXD6  23 N.C. 24 N.C. 
25 VCC 26 P73/KR3  25 VSS 26 P15/TOH0  25 N.C. 26 N.C. 
27 VCC 28 P74/KR4  27 VSS 28 P16/TOH1/INTP5  27 N.C. 28 N.C. 
29 VCC 30 P75/KR5  29 VSS 30 P17/TI50/TO50  29 N.C. 30 N.C. 
31 VCC 32 P76/KR6  31 VSS 32 P20/ANI0  31 N.C. 32 N.C. 
33 VCC 34 P77/KR7  33 VSS 34 P21/ANI1  33 N.C. 34 N.C. 
35 VCC 36 P120/INTP0/EXLVI  35 VSS 36 P22/ANI2  35 N.C. 36 N.C. 
37 VCC 38 P121/X1  37 VSS 38 P23/ANI3  37 N.C. 38 N.C. 
39 VCC 40 P122/X2  39 VSS 40 P24/ANI4  39 N.C. 40 N.C. 
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3.17 Microcontroller Memory Map 

The MCU’s memory layout is shown in Figure 11. 

Figure 11. Microcontroller Memory Map 

 

The DemoKit-LG2 does not reserve any resources of the MCU; consequently all available MCU 
memory is free for application software. 
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4. On-Chip Debugging 

The DemoKit-LG2 board offers two possibilities for on-chip debugging (OCD). The on-board 
debugging function allows on-chip debugging without a need for external debugging hardware. In this 
mode, the default USB / UART connection to the host computer serves as the debugging interface. All 
standard debugging functions, such as flash programming / downloading, code execution, single-step 
command execution, breakpoint setting, memory manipulation and so forth, are available in this mode. 

The DemoKit-LG2 also supports use of the QB-78K0MINI on-chip debugging emulator to enable the 
MCU’s on-chip debugging function. The system configuration for this type of debugging is shown in 
Figure 12. 

Figure 12. System Configuration for On-Chip Debugging 

  
 

4.1 On-Board Debugging 

To enable the DemoKit-LG2’s on-board debugging mode, you must configure switch SW1 and the 
JP1–JP3 jumpers as described in Table 8. 
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Table 8. Switch and Jumper Settings for On-Board Debugging 
Switch/Jumper Setting Mode 

SW1/S1 OFF Normal operation 

SW1/S2 OFF UART6 select 

SW1/S3 ON OCD enabled 

SW1/S4 OFF On-board debugging function 

JP1 1–2 closed Power supply via USB 

JP2 Open Power supply via USB 

JP3 Closed Clock supplied via CPLD 

4.2 On-Chip Debugging with the QB-78K0MINI Emulator 

To use the QB-78K0MINI on-chip debugging emulator to enable the MCU’s on-chip debugging 
function, you must configure the SW1 switches and jumpers JP1–JP3 as described in Table 9. 

Table 9. Switch and Jumper Settings for On-Chip Debugging with the QB-78K0MINI Emulator 
Switch/Jumper Setting Mode 

SW1/S1 OFF Normal operation

SW1/S2 OFF UART6 select

SW1/S3 ON OCD enabled

SW1/S4 ON QB-78K0MINI enabled

JP1 1–2 closed Power supply via USB

Open Power supply via USBJP2 

Closed Power supply via QB-78K0MINI (*Note) 

JP3 Open Clock supplied via QB-78K0MINI  

Note: When using power from the QB-78K0MINI, do not connect external hardware to the DemoKit-
LG2 board as the board can operate without external USB or battery power. 
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5. Installation and Operation 

The Windows-based FPL3 flash programming software enables selection and downloading of 
application programs to the DemoKit-LG2 board. The board communicates with a host computer via a 
USB interface that must be installed properly before you can download and run a program. 

Figure 13. CD-ROM Directory Structure  

 DemoKit-LG2 (F:) CD-ROM ROOT 

  fscommand  

   NECTools - NEC Electronics Software Tools 

               FPL3 - FPL3 flash programming software 

              Drivers  … USB driver 

              FPL3  … FPL3 setup directory 

              PRM  … PRM parameter files 

                           SampleProgram - Sample program for DemoKit-LG2 

  Documentation - Documentation 
 

5.1 Hardware Installation 

Connect the board to the host computer using the provided USB interface cable. 

5.2 Software Installation 

The DemoKit-LG2 package comes with several software demo packages: 

� NEC Electronics software tools for 78K0 MCUs, including a C compiler, assembler, linker, 
librarian and ID78K0-TK/ID78K0-QB debuggers. 

� FPL3 flash programming software 

� Sample program 

5.2.1 Software Tools 

To install the NEC Electronics software tools for 78K0 MCUs, select the SETUP program in the 
\fscommand\NECTools\ directory of the CD-ROM. The Setup boxes will guide you through the 
installation process. The product ID for DemoKit-LG2 is 00101386V. 

5.2.2 FPL3 Flash Programming GUI Installation 

To install the FPL3 flash programming GUI, select the SETUP program in the \fscommand\FPL3\ 
directory of the CD-ROM. The Setup boxes will guide you through the installation process. 
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5.2.3 Sample Program   

To use sample/demonstration program for the DemoKit-LG2 board, copy the directory 
\fscommand\SampleProgram\ on the CD-ROM to you local hard drive.  Remember to remove the   
"read only" attribute from the files. 

5.2.4 USB Driver Installation 

To use the board for on-chip debugging or flash programming, install the USB driver in accordance 
with the procedure for your particular operating system. 

5.2.4.1 Installation on Windows 98SE/Me 

1. When you connect the board to the host computer, the Plug and Play function recognizes 
the board and initializes the wizard for adding new hardware. Click Next. 

Figure 14.  Add New Hardware Wizard (Windows 98SE) 
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2. Select the Search for the best driver for your device box and then click Next. 

Figure 15. Search Method (Windows 98SE) 

 

3. Select the Specify a location box, browse to and select C:\ProgramFiles\NECTools32\ 
FPL3\DRIVER, and then click Next. 

Figure 16. Search Location Specification (Windows 98SE) 

 

Note: If the destination folder changes when the GUI software is installed, type the new-
folder\DRIVER name in the Specify a location box. 
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4. Click Next. 

Figure 17. Checking Driver to Be Installed (Windows 98SE) 

 

5. Click Finish to complete the installation. 

Figure 18. Installation Completion (Windows 98SE) 
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5.2.4.2 Installation on Windows 2000 

1. When you connect the board to the host computer, the Plug and Play function recognizes 
the board and initializes the wizard for adding new hardware. Click Next. 

Figure 19. Found New Hardware Wizard 1 (Windows 2000) 

 
 

2. Select the Search for a suitable driver for my device box and then click Next. 

Figure 20. Search Method 1 (Windows 2000) 
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3. Select the Specify a location box and then click Next. 

Figure 21. Driver File Location 1 (Windows 2000) 

 

4. Browse to and select C:\Program Files\NECTools32\FPL3\DRIVER and then click OK. 

Figure 22. Address Specification 1 (Windows 2000) 

 

Note: If the destination folder changes when the GUI software is installed, type the new-
folder\FPL3\DRIVER name in the Copy manufacturer’s files from: box. 
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5. Click Next. 

Figure 23. Driver File Search 1 (Windows 2000) 

 

6. Click Finish to complete the installation of the USB converter. 

Figure 24. USB Serial Converter Installation (Windows 2000) 
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7. To proceed to the USB driver installation, click Next. 

Figure 25. Found New Hardware Wizard 2 (Windows 2000) 

 

8. Select the Search for a suitable driver for my device box and click Next. 

Figure 26. Search Method 2 (Windows 2000) 
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9. Select the Specify a location box and click Next. 

Figure 27.  Driver File Location 2 (Windows 2000) 

 

10. Browse to and select C:\Program Files\NECTools32\FPL3\DRIVER and then click OK. 

Figure 28. Address Specification 2 (Windows 2000) 

 

Note: If the installation destination folder changes at the time of GUI software installation, enter 
the new-folder\DRIVER name in the Copy manufacturer’s files from box. 

11. Click Next. 

Figure 29. Driver File Search 2 (Windows 2000) 
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12. Click Finish to complete the installation of the USB driver. 

Figure 30. USB Driver Installation (Windows 2000) 

 

5.2.4.3 Installation on Windows XP 

1. After the board is connected to the host computer, the Plug and Play function recognizes the 
board and initializes the wizard for finding new hardware. Select the Install from a list or 
specific location box and then click Next. 

Figure 31. Found New Hardware Wizard 1 (Windows XP) 
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2. Select the Search for the best driver in these locations and Include this location in the 
search: boxes, browse to and select C:\Program Files\NECTools32\FPL3\DRIVER, and 
then click Next. 

Figure 32. Search Location Specification 3 (Windows XP) 

 
 

3. When you receive the has not passed Windows Logo testing to verify its compatibility with 
Windows XP message, click Continue Anyway. 

Figure 33. Windows XP Logo Testing 3 (Windows XP) 
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4. Click Finish to finish the installation of the converter. 

Figure 34. USB Serial Converter Installation (Windows XP) 

 

5. To proceed to the installation of the USB serial port driver, click Next. 

Figure 35. Found New Hardware Wizard 2 (Windows XP) 
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6. Select the Search for the best driver in these locations and Include this location in the 
search: boxes, browse to and select C:\Program Files\NECTools32\FPL3\DRIVER, and 
then click Next. 

Figure 36. Search Location Specification 2 (Windows XP) 

 

7. When you receive the has not passed Windows Logo testing to verify its compatibility with 
Windows XP message, clock Continue Anyway. 

Figure 37. Windows XP Logo Testing 2 (Windows XP) 
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8. Click Finish to complete the installation of the driver. 

Figure 38. USB Serial Port2 Driver Installation Completion (Windows XP) 

 

5.3 Confirmation of USB Driver Installation 

After installing the two types of drivers, which are needed for using the DemoKit-LG2 board with FPL3 
GUI, you can verify that they were installed successfully by checking the Device Manager directory. 

Figure 39. Device Manager Directory 

 
� For Windows 98SE/Me: Do not execute Update and Erase commands when communicating with 

the target device. 

� For Windows 200/XP: Do not execute a Hardware Modification Scan when communicating with 
the target device. 

� In the GUI port list, select the same communication port as COM? of the USB serial port. 

� If the drivers highlighted in Figure 39 are not displayed, or the mark "×" or "!" is prefixed, refer to 
Section 10, “Troubleshooting.” 

5.4 Driver Uninstallation 

The driver uninstallation program is installed on the host computer when the FPL3 software is installed. 
Use the procedure below for uninstalling the USB driver. 
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1. When using Windows XP, log on as the computer administrator. When using Windows 
2000, log on as the Administrator. 

2. Double-click My Computer → C:\Program Files → NECTools32 → FPL3 → DRIVER 
→ Ftdiunin.exe. 

Figure 40. Driver Uninstallation 

 

3. Click Continue. 

Figure 41. FTDI Uninstaller 

 

4. Click Finish to complete driver uninstallation. 

Figure 42. Completion of Driver Uninstallation 

 

Caution: If the GUI software was uninstalled earlier, then the Ftdiunin.exe file was also 
deleted.  At this time, manually delete "USB Serial Port (COM?)" and "USB High Speed 
Serial Converter" from the Device Manager directory.
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6. FPL3 Flash Programming Software 

The MCU’s parameter file is automatically stored in the <FPL3 install-path>\PRM folder during 
installation of the FPL3 GUI. Nevertheless, the most up-to-date file can be downloaded from the NEC 
Electronics America web site at http://www.am.necel.com/microcontrollers/devtools.php and copied 
into <FPL3.EXE-install-path>\PRM. Refer to Section 5.2, “Software Installation.” 

6.1 Starting the GUI Software 

On the Start menu, click FPL3.EXE to initialize the GUI software (Figure 43). 

Figure 43. Main Window of the GUI Software 

 

Menu Bar 

Toolbar 

Action Log Window 

Status Bar 

 

Table 10. Components of the Main Window 
Name Description 

Menu bar Displays FPL3-executable commands 

Toolbar Displays icons of frequently used commands 

Action Log window Displays FPL3 action log

Programmer Parameter window Displays programming parameter settings 

Status bar Displays status information

6.2 Toolbar 

The toolbar contains buttons for executing FPL3 commands (Figure 44). 

Figure 44. Toolbar Buttons 

 
Device → Setup button 

 
File → Load button 

 

Programmer
Parameter 
Window
39

http://www.am.necel.com/microcontrollers/devtools.php
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Device → Blank Check button 

 
Device → Erase button 

 
Device → Program button 

 
Device → Verify button 

 
Device → Autoprocedure(EPV) button 

6.3 Menu Bar 

Depending on the actual device status and type, some commands of the commands discussed in this 
section may be disabled. 

6.3.1 File Menu 

The File menu displays a list of commands related to file operation. 

 

Figure 45. File Menu 
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6.3.1.1 Load Command 

The Load command selects the file to be programmed into the MCU’s flash memory. 

Figure 46. Open Dialog Box 

 

The Open dialog box displays the directory containing the most recently loaded user program. 
After the program is loaded, the checksum is calculated, and the result displayed in the 
Programmer Parameter window. 

6.3.1.2 Quit Command 

The Quit command terminates the FPL3 GUI software. (Clicking × on the right of the task bar 
also terminates the FPL3 GUI software.) 

User settings are saved in the FPL3.INI file to preserve them for the next session. FPL3.INI is 
stored in the Windows folder in Windows 98SE, Windows Me, and Windows XP operating 
systems. In Windows 2000, FPL3.INI is stored in the Winnt folder.) 
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6.3.2 Device Menu 

The Device menu displays the programming commands. 

 

Figure 47. Device Menu 

 

6.3.2.1 Blank Check Command 

The Blank Check command executes a blank check on the target device connected to the FPL3 
programmer. If the target MCU’s flash memory has been erased, the blank check terminates 
normally. If the flash memory has not been erased completely, the program displays a not blank 
message, after which you will need to execute an Erase command. 

6.3.2.2 Erase Command 

The Erase command erases the flash memory of the MCU connected to the FPL3 programmer.  
While the flash memory is being erased, the Action Log window displays the progress. Upon 
completion, the GUI software displays the result of the command on the target device. 

Execution of a Blank Check command before an Erase command depends on the setting of the 
Advance properties in the Device Setup box (Table 13). 

6.3.2.3 Program Command 

The Program command sends a specified user program to the target device and writes the 
program to the device’s flash memory. During programming, the Action Log window displays 
the progress. Upon completion, the GUI software displays the result of the command on the 
target device. 

Execution of a Verify command after execution of a Program command depends on the 
settings of the Advance properties in the Device Setup box (Table 12). 
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6.3.2.4 Verify Command 

The Verify command sends a specified user program to the target device and verifies the 
program against the data written to the device’s flash memory. During verification, the Action 
Log window displays the progress. Upon completion, the GUI software displays the result of 
the command on the target device. 

6.3.2.5 Security Command 

The Security command programs the security flag of the target device connected to the FPL3 
(Table 12). 

6.3.2.6 Checksum Command 

The Checksum command reads the checksum value of the target device connected to the FPL3. 
This value differs from the value displayed in the Programmer Parameter window. 

6.3.2.7 Autoprocedure(EPV) Command 

The Autoprocedure(EPV) command executes Erase, Program, and Verify commands in 
succession. During execution, the Action Log window displays the progress. Upon completion, 
the GUI displays the results. For detailed information, refer to Section 7, “How to Use the FPL3 
Flash Programmer.” 

To have data written to flash memory automatically verified after a Program command, click 
Device → Setup. On the Advance tab, select Read verify after Program (Table 12). 

6.3.2.8 Signature Read Command 

The Signature read command reads the target device’s signature information, including device 
name, flash memory information, and so forth. 

6.3.2.9 Setup Command 

The Setup command allows you to select user environment and command options. Upon 
initialization, the GUI software reverts to the most recently used parameter file (.PRM). The 
Setup command allows you to modify those settings. 

 43



DemoKit-LG2 User’s Manual  
 
 

 44

• Standard Properties: The Standard tab contains options for the parameter file, host 
connection, supply oscillator, and operating mode. Refer to the user’s manual for the target 
device when setting properties. 

Figure 48. Device Setup Box: Standard Tab 

 

Table 11. Device Setup Box: Standard Properties 
Group/Item Option Description 

Parameter file — Specifies the parameter file to be rewritten into the target MCU’s flash memory

  
Note: parameter file data must not be revised because it is related to the 
guarantee of rewrite data. The checksum function protects the parameter file. If 
the checksum result indicates an error, the FPL3 does not accept the file. 

PRM File 
Read button — Opens a window for specifying a parameter file is displayed.  Specify a desired 

file then click Open 

Selects a channel from COM1 to COM256 for communication between the 
DemoKit-LG2 board and host computer

Port list box 
Ports also can be selected using the Device Manager, as explained in Section 
5.3, “Confirmation of USB Driver Installation.” 

Host 
connection 

Speed list box 

Selects a communication rate for the selected communication channel: 
•  9600 bps  
•  19200 bps  
•  38400 bps 
•  115200 bps  
For selectable communication rates, refer to the MCU user's manual.

Frequency box Sets the clock frequency of the target system; operating frequency varies by 
device, so always check device specifications before setting the frequency

Specifies the division rate or multiplication rate of the target device. If the 
target device has an on-chip PLL circuit, enter a division rate or multiplication 
rate according to the user environment. The selectable division rate or 
multiplication rate differs depending on the device 

Supply 
oscillator 

Multiply rate 

Before making a selection, check the specifications of the device used. If the 
target device does not have an on-chip PLL circuit, select "1.0". On the initial 
screen, the default setting is displayed according to the parameter file.
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Group/Item Option Description 

Chip Subjects the entire flash memory area of the target device to rewriting 

Block Specifies a block of flash memory to be rewritten 

Area Specifies an area to be rewritten. The Start/End list boxes display the Area 
numbers where the flash memory of the target device is configured.

Operation 
Mode (some 
modes not 
available in 
all devices) 

Show Address 
box 

Specifies whether numbers or addresses are displayed in the Start/End boxes. If 
selected, addresses are displayed. If not selected, numbers are displayed.

Target Reset 
Message — Displays the window promoting the manual reset operation, even when the 

reset signal cannot be connected to the target cable. 

• Advance Properties: The Advance tab contains command options and security flag settings. 

Figure 49. Device Setup Box: Advance Tab 

 

Table 12. Device Setup Box: Advance Properties 
Group/Item Option Description 

Blank check 
before Erase 

Performs a Blank Check before executing an Erase or Autoprocedure 
(EPV) command. If the result of a blank check indicates OK, the Erase 
command is not executed 

Read verify 
after Program 

Sends write data from the programmer after execution of the Program and 
Autoprocedure (EPV) commands, and then verifies the data against the data 
written to flash memory 

Security flag 
after Program 

Automatically programs the selected security flag after execution of the 
Program and Autoprocedure (EPV) commands 

Command 
options 

Checksum 
after Program 

Reads the flash memory checksum value of the target device after execution of 
Program and Autoprocedure (EPV) commands; this value differs from the 
value displayed in the Parameter Programming window 

Disable Chip 
Erase 

Invalidates the Erase command in the entire flash memory area of the target 
device and displays a warning stating that When chip erase is disabled, chip 
cannot be erased and programmed anymore!” Caution: If the security flag is 
set in the target device, erasing and writing to the device cannot be enabled. 

Disable Block 
Erase 

Invalidates the Erase command in all blocks of flash memory selected under 
Operation Mode in the Standard tab of the Device Setup box; this setting is 
cleared by the Erase command if chip is selected under Operation Mode

Security flag 
settings  

Disable 
Program 

Invalidates the Program and Erase commands in all blocks of flash memory 
selected under Operation Mode in the Standard tab of the Device Setup box. 
The Erase command for the entire flash memory area is valid. This setting is 
cleared by the Erase command if chip is selected for Operation Mode. 
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Group/Item Option Description 

Disable Boot 
block cluster 
reprogramming 

Uses the last block cluster setting as the current setting and displays a warning 
message stating that When boot block cluster programming is disabled, boot 
block cannot be erased and programmed anymore. Caution: If the security 
flag is set in the target device, the boot area cannot be rewritten afterward.

 

Table 13. Relationship Between Erase and Program Commands When MCU Security Functions are Valid 
Command 

Option Chip 
Erase Block Erase Program 

Disable Chip Erase Invalid Invalid 
Valid (since the Erase command is 
invalid, data that differs from data already 
written in flash memory cannot be written) 

Disable Block Erase Valid Invalid Valid

Disable Program Valid Invalid Invalid

Disable Boot block cluster 
reprogramming Invalid Valid (except for 

specified boot area) Valid (except for specified boot area) 

6.3.3 View Menu 

The View menu contains commands for displaying or hiding the toolbar and status bar. 

Figure 50. View Menu 

 

6.3.3.1 Toolbar Command 

Select the Toolbar command to display the toolbar; clear the command to hide the toolbar. 

6.3.3.2 Status Bar Command 

Select the Status Bar command to display the status bar; clear the command to hide the status 
bar. 

6.3.4  Help Menu 
The Help menu contains the About FPL3 . . . command. 

Figure 51. Help Menu 
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The About FPL3 box displays copyright information and the program version number. 

Figure 52. About FPL3 Box 

 

6.4 Programmer Parameter Window 

This Programmer Parameter window displays the settings of the programming parameters. 

Figure 53.  Programmer Parameter Window 

 

Table 14. Programmer Parameter Window 
Group Description 

Device After communication with the target device, displays updated information about the target

Parameter file After Setup command execution, displays information about a read parameter file 

Load file After Load command execution, displays information about the selected program file 

Connection to device After Setup command execution, displays information about the connection to the target 
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7. How to Use the FPL3 Flash Programming Software 

This section explains the basic operation of the FPL3 GUI for programming the DemoKit-LG2 board, 
including how to start the system, execute the Autoprocedure (EPV) command, and program the target 
device. Table 15 and Table 16 list the specifications for the series of operations described. 

Table 15. Hardware Configuration of DemoKit-LG2 
Base Board DemoKit-LG2 

Target device 78K0/LG2 (µPD78F0397D)

Clock 6 MHz

Voltage level 5 V

Table 16. Software Configuration of FPL3 
Parameter File µ78F0397D.PRM 

Clock setting 6 MHz (multiplied by 1)

Port COM3 (115200 bps)

Operation mode Chip

Write HEX 78K0 LCD DEMO.hex 

Option setting Blank check before Erase

7.1 Installing the FPL3 GUI software 

Install the FPL3 GUI software on the host machine you are using, by referring to CHAPTER 7 
SOFTWARE INSTALLATION (if the software has not been installed yet). 

7.2 Installing the Driver 

Install the USB driver on the host computer as described in Section 5.2, Software Installation.” 

7.3 Installing the Parameter File 

The parameter file for the MCU is automatically stored in <FPL3 install-path>\PRM during FPL3 
installation. Nevertheless, the newest version of the parameter file can be downloaded from the NEC 
Electronics America web site (http://www.am.necel.com/microcontrollers/devtools.php) and copied into 
the <FPL3.EXE-install-path>\PRM subdirectory whenever a new version is available. 
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7.4 Connecting and Starting 

1. Switch SW1/S1 to ON to initiate flash programming mode. 

Figure 54. Switch and Jumper Settings in Flash Programming Mode 

SW1 Setting Mode 
S1 ON Programming mode 
S2 OFF UART6 select 
S3 OFF OCD disabled 
S4 OFF On-board debugging function 
Jumper Setting Mode 
JP1 1–2 closed Power supply via USB 
JP2 Open Power supply via USB 
JP3 Closed Clock supplied via CPLD 

2. Connect the DemoKit-LG2 board to the host computer via the USB cable. If the connection was 
already made, press the SW2 reset button to exit flash programming mode. 

3. Start the FPL3 GUI. 

Figure 55. GUI Software Main Window 

 
4.  Click Device → Setup to set the programming environment. 

Figure 56. Device Setup Box: Standard Tab 

 
5. On the Standard tab, click PRM File Read to open the Parameter File box. 

6. Select 78F0397D.prm and then click Open. 
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Figure 57. Parameter File Selection 

 
7. In the Port box, select the communication port that matches the host computer being used. 

8. In the Speed box, select the communication speed of the host connection. 

Figure 58. Port Selection 

 

Note: Ports can be selected using Device Manager, as explained in Section 5.3, “Confirmation of USB 
Driver Installation.” 

9. Set "Supply oscillator" according to the specifications of the DemoKit-LG2 board, “Frequency = 
6.00 MHz” and “Multiply rate = 1.00”. In "Operation Mode", specify the “Chip” mode. The 
following figure shows the recommended settings: 

Figure 59. Standard Property Settingss 

 



DemoKit-LG2 User’s Manual  
 
 

10. Click the Advance tab. 

Figure 60. Device Setup Dialog Box: Advance Tab  

 
11. Select Blank check before Erase and then click OK to set the parameters. 

Figure 61. Completion of Parameter Setting 

 

The display is 
updated. 

PRM File Read 
OK is displayed. 

7.5 Selecting a User Program 

1. Click File → Load. 

2. Select a program file to be written to the target device and then click Open. 

Figure 62. After Downloading 

 

"Success read HEX 
file." is displayed. 

The display is 
updated.
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7.6 Autoprocedure(EPV) Command Execution 

Click Device → Autoprocedure(EPV) to execute the Blank Check, Erase, Program, and Verify 
commands in succession. 

Figure 63. After EPV Execution 

 

"...finish" is 
displayed.

7.7 Terminating the GUI 

Click File → Quit to terminate the GUI software. All settings in effect upon termination are preserved 
in the FPL3.INI file for recall at the next session. 

7.8 78K0_LCD_DEMO Application 

Switch SW1/S1 to OFF to set the DemoKit-LG2 board to normal operation. Press the SW2 reset button 
to exit normal operation. 



DemoKit-LG2 User’s Manual  
 
 
8. TROUBLESHOOTING 

Table 17. Recommended Actions to Correct Problems 
Problem Cause Recommended Action 

Verify that the USB connector is inserted 
fully into the host’s USB port. 

Faulty Plug and Play recognition 
during driver installation 

The USB connector may not be inserted 
normally into the USB port of the 
personal computer. 

Alternatively, disconnect the USB 
connector, and then re-insert it after a 
while.

The driver file cannot be found in 
the specified location. 

The FPL3 flash programming software 
may not be installed correctly. 

Install the software again by referring to 
Section 5.2, “Software Installation.” 

Check that the USB connector is inserted 
fully into the host computer’s USB port.The USB connector may not be inserted 

normally into the USB port of the 
personal computer. 
 

Alternatively, disconnect the USB 
connector from the USB port and then re-
insert it again after a while. 

1. When this product is connected to the 
host computer, right-click the driver 
prefixed with an exclamation mark (!) 
or × and then click Erase. 

2. On the Device Manager, execute a 
Hardware Modification Scan.

The driver may not be installed correctly. 

3. Install the driver again. 

Disconnect the USB connector and then 
re-insert it again. 

Connect the USB connector to another 
port of the USB hub. 

"USB Serial Port" or "USB High 
Speed Serial Converter" are not 
displayed; alternatively, they are 
displayed but prefixed with an 
exclamation mark (!)  or ×. 

The device may not be recognized (in the 
case of connection with the USB hub) 

If the same symptom occurs, do not use 
the USB hub, but directly connect the 
connector to the USB port of the personal 
computer. 

When the DemoKit is connected 
with a host computer, the "Add 
New Hardware Wizard" screen is 
displayed. 

If the USB connector of this product is 
not inserted into the USB port used at the 
installation time but into another USB 
port, then this product may be recognized 
as a new hardware item.

Install the driver as described in Section 
5.2.4, “USB Driver Installation.” 

The driver may not be installed correctly. 

Verify that the USB serial port and high-
speed serial converter were installed 
correctly, as described in Section 5.2.4, 
“USB Driver Installation.” 

The communications port selected in the 
Port box on the Standard tab of the 
Device Setup box may not be set 
correctly. 

Set the port using the Device Manager. 

The DemoKit-LG2 board is operating in 
normal mode.

Set the board to flash programming mode 
by setting SW1 switch S1 to ON.

The PRM file selected on the Standard 
tab of the Device Setup box may be 
incorrect. 

Use the PRM file that matches the target 
device. For information about the PRM 
file, refer to Section 7, “How to Use the 
FPL3 Flash Programming Software.”

Communication with the DemoKit-
LG2 board is disabled. 

The setting of Supply oscillator on the 
Standard tab of the Device Setup box 
may be incorrect. 

Make a correct setting according to the 
specifications of the target device. 
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9. Sample Project 

The DemoKit-LG2 sample program resides in a single directory called main-directory, which contains 
all of the output files for NEC Electronics’ integrated development environment (IDE). 

The main directory contains the workspace and project files. All source files and associated files are 
located in the directory. The workspace file is named DemoKit-LG2.prw is provided to demonstrate 
the 78K0/LG2 MCU’s functionality. 

9.1 Real-Time Clock 

This part of the sample project realizes a real-time clock. After the program initializes, the watch timer 
generates an exact clock reference based on the 32.768 kHz subclock and the LCD displays the time in 
either 24-hour or AM/PM clock format, depending on the setting selected. 

9.2 Temperature Measurement 

Temperature is measured using the dual-slope method to convert the temperature sensor’s resistor value 
into a digital counter-value. To do this, the MCU 16-bit timer/event counter 00 measures the charging 
time of the C18 capacitor. The first charging slope uses a reference resistor (RREF = R6) and the second a 
variable resistor (RVAR= R5 + RT), which should be determined. The variable resistor of the temperature 
sensor, and consequently the temperature, can be calculated by comparing the two measured times and 
the known RREF reference resistor. The LCD displays the temperature in degrees Celsius or degrees 
Fahrenheit, depending on the setting selected. Additionally, the temperature is transferred via UART6 at 
the default data transfer speed of 115200 bits per second to a terminal program running on the host 
computer. 

9.3 Light Incidence Measurement 

This part of the sample project measures light incidence. The MCU’s A/D converter (channel 0) is used 
to measure a voltage cycle at the phototransistor and the result is converted into a percent value and 
displayed on the LCD. 

9.4 Buzzer Output Example 

This demonstration drives the buzzer by using the 16-bit timer/event counter 01. The timer is 
configured to generate a rectangular waveform. By changing the output frequency of the timer, the 
buzzer can generate different tones. For demonstration purposes, a simple melody is played. 

9.5 Menu Selection 

To shift between the different operating modes of the sample project, follow the menu configuration 
shown in Figure 64. The first column shows the main menus and the second the sub-menus. Move SW3 
up or down to switch from one menu to another and from left to right to switch between sub-menus. 
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Figure 64. Sample Project Menus 
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9.5.1 Setting the Time 

To adjust the clock, go the SET submenu. Move SW3 left or right to switch between hours and minutes; 
move SW3 up or down to select the time. To leave the sub-menu, press SW3. 

9.5.2 Setting the Clock Format 

To set the clock format, go to the MODE sub-menu. Move SW3 up or down to select between 24-hour 
format and AM/PM format. To leave the sub-menu, move SW3 to the left. 

9.5.3 Setting the Temperature Format 

To set the temperature format, go to the TEMP sub-menu. Move SW3 up or down to select between 
degrees Celsius and degrees Fahrenheit. To leave the sub-menu, move SW3 to the left. 
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10. NEC Electronics IDE and ID78K0-TK Debugger 

The DemoKit-LG2.prw project workspace is included for real-time debugging with the ID78K0-TK 
debugger. To initialize the integrated development environment (IDE), click Start → Programs → 
NEC Tools32 → PM Plus. 

Figure 65. PM Plus 

 

To open the sample program, click File → Open → DemoKit-LG2.prw. 

Figure 66. PM Plus with Sample Code 

 

Once the workspace is open, the PM Plus Project Window lists all files associated with the project, 
including the source code and header files. From PM Plus, you can edit, build and link the sample code 
provided.  For detailed information about the NEC Electronics software tools, refer to the associated 
documents for each. 

To perform debugging of the code and board make sure that the DemoKit-LG2 board is configured for 
on-chip debugging.  You must configure the port setting for the serial communication using the 
Portconfig for ID78K0-TK from the Windows Start menu → Programs → NEC Tools32. 
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Figure 67. Portconfig for ID78K0-TK 

 

After the port has been set for ID78K0-TK, from PM Plus you can invoke ID78K0-TK by selecting 
Tools → Debug.   

Figure 68. ID78K0-TK Debugger 

 
 

To open the debugger separately, without PM Plus, click NEC Tools32 → ID78K0-TK and then enter 
main.lmf to download the sample code. 
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11. Cable 
Figure 69. USB Interface Cable (Mini-B Type) 
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12. Schematics 

 

 

 59



DemoKit-LG2 User’s Manual  
 
 

 60

 



DemoKit-LG2 User’s Manual  
 
 

 
 
 

 61



DemoKit-LG2 User’s Manual  
 
 

 62

 


	User’s Manual
	DemoKit-LG2
	Demonstration Kit for
	NEC Electronics 78K0/Lx2 Microcontrollers
	Revision History



	Contents
	Introduction
	Features
	System Requirements
	Kit Contents

	System Configuration
	DemoKit-LG2
	Host Computer
	Power Supply via USB Interface

	Components
	Jumper JP1: Power Supply Selection
	Jumper JP2: Power Selection for On-Chip Debugging
	Jumper JP3: Clock Supply Selection
	SW1 Configuration Switches
	SW1/S1: Operating Mode Selection
	SW1/S2: UART Selection
	SW1/S3: On-Chip Debugging Selection
	SW1/S4: On-Chip Debugging Mode Selection

	SW2 Reset Switch
	SW3 Navigation Switch
	SB1, SB3, SB4, SB5 and SB6 Soldering Bridges
	CN7 USB Interface Connector
	CN2 Flash Programmer Connector
	OCD connector CN8
	LCD1 Standard 112-Segment LCD
	Temperature Sensor
	Q1 Phototransistor
	BUZ1 Buzzer
	BAT1 Battery Holder
	CN3, CN4 and CN5 External Connectors
	Microcontroller Memory Map

	On-Chip Debugging
	On-Board Debugging
	On-Chip Debugging with the QB-78K0MINI Emulator

	Installation and Operation
	Hardware Installation
	Software Installation
	Software Tools
	FPL3 Flash Programming GUI Installation
	Sample Program
	USB Driver Installation
	Installation on Windows 98SE/Me
	Installation on Windows 2000
	Installation on Windows XP


	Confirmation of USB Driver Installation
	Driver Uninstallation

	FPL3 Flash Programming Software
	Starting the GUI Software
	Toolbar
	Menu Bar
	File Menu
	Load Command
	Quit Command

	Device Menu
	Blank Check Command
	Erase Command
	Program Command
	Verify Command
	Security Command
	Checksum Command
	Autoprocedure(EPV) Command
	Signature Read Command
	Setup Command

	View Menu
	Toolbar Command
	Status Bar Command

	Help Menu

	Programmer Parameter Window

	How to Use the FPL3 Flash Programming Software
	Installing the FPL3 GUI software
	Installing the Driver
	Installing the Parameter File
	Connecting and Starting
	Selecting a User Program
	Autoprocedure(EPV) Command Execution
	Terminating the GUI
	78K0_LCD_DEMO Application

	TROUBLESHOOTING
	Sample Project
	Real-Time Clock
	Temperature Measurement
	Light Incidence Measurement
	Buzzer Output Example
	Menu Selection
	Setting the Time
	Setting the Clock Format
	Setting the Temperature Format


	NEC Electronics IDE and ID78K0-TK Debugger
	Cable
	Schematics

